EndNote: Working in Word and troubleshooting common issues

EndNote is a bibliographic management / referencing software that allows you to create, organise and maintain a personal database of references called an EndNote Library.

When you use EndNote to insert citations from this library into your documents, it will generate a reference list for you.
Contents

Working in Word using Cite While You Write (CWYW) ................................................................. 3
Choose or change the referencing style used in your document .................................................. 3
Insert an in-text citation – (Author/s, Year) .................................................................................. 4
Insert an in-text citation – Author/s (Year) .................................................................................. 5
Insert multiple citations for the same quote .................................................................................. 6
Edit an existing citation to add another citation to the same brackets ........................................ 7
Edit a citation to add a page number ........................................................................................... 9
Edit a citation to display the acronym in place of the organisation’s full name: ....................... 10
Remove citations ....................................................................................................................... 11
Format your bibliography ........................................................................................................... 12
Edit your document safely using Convert to Unformatted Citations ........................................... 13
Combining the chapters of your thesis using Convert to Unformatted Citations ......................... 15
Remove EndNote coding before you submit your document ..................................................... 19
Create bibliographies that are not linked to a document ............................................................. 21
Create an independent reference list .......................................................................................... 21
Create a Subject Bibliography .................................................................................................... 23
Working with figures ...................................................................................................................... 25
Create a Figure record and attach an image file ......................................................................... 25
Using EndNote to insert figures into your document .................................................................. 26
Troubleshooting ............................................................................................................................ 29
Correcting Details in an in-text citation or reference list: ......................................................... 29
Journal title abbreviations for your reference list ........................................................................ 31
Removing Author Initials from in-text citations: ........................................................................ 33
Part 1: Tidy up your Author Terms ............................................................................................. 33
Part 2: Tidy up your records ....................................................................................................... 34
Part 3: Edit the output style to remove author initials ................................................................. 35
Superscript numbers for in-text citations .................................................................................... 37
Back up your library ..................................................................................................................... 39
How do I get help with EndNote? .............................................................................................. 40
Self help ..................................................................................................................................... 40
For help installing EndNote, or fixing software issues contact TaSAC: .................................... 40
For help using EndNote ............................................................................................................... 40
Working in Word using Cite While You Write (CWYW)

The Cite While You Write (CWYW) function allows you to insert references from your EndNote library into a Word document while you are writing. EndNote will build a bibliography/reference list for you as you insert citations. This list will appear at the end of the document. It will be sorted alphabetically by lead author surname.

When you click on an EndNote citation in your document, you will see that it is highlighted in grey. This indicates that the citation has EndNote formatting that links it directly to your EndNote library.

Choose or change the referencing style used in your document

You can choose any style that has been added to your EndNote library. See Find and select output styles in the Building and organising your library workbook for more information on adding new styles.

1. Go to the EndNote toolbar in Word

2. Click the down arrow beside the Style box to bring up a list of styles

3. If the style you need is listed, select it from this menu. Your citations and bibliography will update to this style.

4. If the style you need is not listed, click Select Another Style. This opens a window with the full range of options.

5. Browse the list to locate the style you want.

6. Highlight this style and click OK. The new style will appear in the Output styles box in the toolbar and your citations and bibliography will update to this style.
Insert an in-text citation – (Author/s, Year)

1. Insert your cursor where you want the citation to appear. You will need to leave a space after the preceding word.

   Tea, coffee and chocolate are popular beverages. The drinking of tea has always attracted some level of ceremony, but none so much as in Japan where it has become ritualised. Like Art, Tea has its periods and its schools. Its evolution may be roughly divided into three main stages: the Boiled Tea, the Whipped Tea, and the Steeped Tea.

2. Click on Insert Citation in the EndNote toolbar in word. Choose Insert Citation from the drop-down menu.

3. The Find & Insert My References window will open. Type the author’s surname, or some words from the title, or some keywords in the search box at the top left. Click Find.

4. Select the reference from the list of possible references that appear below the search box.

5. Click Insert.

   The citation will appear in your document where the cursor was, e.g. (Okakura, 1906).

   *Tea, coffee and chocolate are popular beverages. The drinking of tea has always attracted some level of ceremony, but none so much as in Japan where it has become ritualised. Like Art, Tea has its periods and its schools. Its evolution may be roughly divided into three main stages: the Boiled Tea, the Whipped Tea, and the Steeped Tea (Okakura, 1906).*

   The reference will appear at the end of the document

**Insert an in-text citation – Author/s (Year)**

Sometimes the author’s names are part of your sentence and you need them to appear outside the brackets for the citation.

1. Insert your cursor where you want the citation to appear. Remember to leave spaces either side of where you are inserting this citation because it is in the middle of a sentence.

   Chocolate is also popular as a food. According to the Spanish people were the first in the Old World to become acquainted with the delights of cacao because they claimed the explorers who conquered and exploited the New World. The western world’s addiction to chocolate spread from there.

2. Click on Insert Citation in the EndNote toolbar in word. Choose Insert Citation from the drop-down menu to open the Find & Insert My References window.

3. Type the author’s surname, or some words from the title, or some keywords in the search box at the top left. Click Find.

4. Select the correct reference from the list of possible matches.

5. Click the arrow beside Insert to bring up your options for formatting your citation and choose Insert & Display as: Author (Year)

![EndNote](image)

The citation will appear in your document where the cursor was, e.g. Purvis (2013)

Chocolate is also popular as a food. According to Purvis (2013) the Spanish people were the first in the Old World to become acquainted with the delights of cacao because they claimed the explorers who conquered and exploited the New World. The western world’s addiction to chocolate spread from there.

The full reference will appear in the list at the end of the document. EndNote add references to the list in alphabetical order by first author surname.


Insert multiple citations for the same quote
Sometimes you have directly quoted or paraphrased an idea that comes from more than one paper. You can use EndNote to insert multiple citations into the one set of brackets.

1. Place your cursor where you want the citations to appear in your document.
2. Open your EndNote library.
3. Locate and highlight the first reference in your EndNote library.
4. Hold down the control key and highlight the other reference/s you want.
5. Click on the Insert Citation Icon in the toolbar of your EndNote library.

The citations will appear in your document in one set of brackets, e.g. (Aerts et al., 2011; Thurston et al., 2013; Garcia et al., 2014).

All 3 references will appear in the list at the end of your document


Edit an existing citation to add another citation to the same brackets

When you are reviewing your work, you might find that you need to add more citations to an existing one, because you have discovered another source for that idea. You can edit the citation to add more.

1. Click on the citation that is already in your document, e.g. (Okakura, 1906).

   Teas, coffee and chocolate are popular beverages. The drinking of tea has always attracted some level of ceremony, but none so much as in Japan where it has become ritualised. Like Art, Tea has its periods and its schools. Its evolution may be roughly divided into three main stages: the Boiled Tea, the Whipped Tea, and the Steeped Tea (Okakura, 1906).

2. Go to the EndNote toolbar in Word.

3. Click Edit & Manage Citation(s). This opens the Edit & Manage Citations window.

4. Open the Edit Reference menu for that existing citation and choose Insert Citation. This opens a Find & Insert My References Window.

5. The Find and Insert my References window will open. Search for the reference you need.
6. Highlight it in the results list and click Insert. This will take you back to the Edit & Manage citations window. You will see both citations grouped together. Click Ok to insert the citation into your document.

Both citations will now appear in the same set of brackets, e.g. (Okakura, 1906; Pitelka, 2013).

Tea, coffee and chocolate are popular beverages. The drinking of tea has always attracted some level of ceremony, but none so much as in Japan where it has become ritualised. Like Art, Tea has its periods and its schools. Its evolution may be roughly divided into three main stages: the Boiled Tea, the Whipped Tea, and the Steeped Tea (Okakura, 1906; Pitelka, 2013).

The extra reference is in the reference list


Edit a citation to add a page number

You need to use the EndNote Edit & Manage Citations to make this work. The page number comes after the author and year, so it’s added as a suffix.

1. Click on the citation to highlight it.

   Tea, coffee and chocolate are popular beverages. The drinking of tea has always attracted some level of ceremony, but none so much as in Japan where it has become ritualised. Like Art, Tea has its periods and its schools. Its evolution may be roughly divided into three main stages: the Boiled Tea, the Whipped Tea, and the Steeped Tea (Okakura, 1906).

2. Click Edit & Manage Citations on the EndNote toolbar. Check that the correct reference is highlighted in the Edit & Manage Citations window when it opens.

3. Go to the Edit Citation section in the lower half of the window.

4. You need to add all of the necessary punctuation, including spaces, yourself. EndNote will not automatically add them in.
   For example, for a citation to look like this: (Okakura, 1906, p.7) Type a comma space p.7, into the Suffix field.

   ![Edit Citation Window]

5. Click OK to close the Edit & Manage Citations window. Back in your document, the citation will now include the page number.

   Tea, coffee and chocolate are popular beverages. The drinking of tea has always attracted some level of ceremony, but none so much as in Japan where it has become ritualised. Like Art, Tea has its periods and its schools. Its evolution may be roughly divided into three main stages: the Boiled Tea, the Whipped Tea, and the Steeped Tea (Okakura, 1906, p.7).

6. Save the changes to your document.

NOTE: If you are using an APA referencing style, you can put the page number into the Pages field. This only works with APA, however, so if you need to change the referencing style later, you will need to edit the citations again using the suffix field.
Edit a citation to display the acronym in place of the organisation’s full name:
Corporate authors such as companies, government departments and research institutes often have acronyms, e.g. the Australian National Data Service uses ANDS. You can edit the in-text citation to use the acronym instead, but still have the full name appear in your reference list.

1. Click on a corporate author citation in your document, e.g. (Australian Bureau of Statistics, 2014)

2. Go to Edit & Manage Citation(s) in the EndNote tool bar in Word. This opens the Edit & Manage Citation(s) window.

3. Select Exclude Author from the Formatting menu.

4. Type the acronym into the Prefix field so that it appears in front of the year. Add a comma, or other punctuation as required by the referencing style. Lastly add a space. EndNote will not add a space between the acronym and the year if you do not.

5. Click OK to close the Edit Citation(s) dialog window.

The in-text citation will now appear as the acronym and year e.g. (ABS, 2014).

Males are 'more likely to drink Sweetened beverages than females (46% compared with 38%)' (Australian Bureau of Statistics, 2014). This includes coffee. Men's coffee consumption spikes in middle age. The older men get the more tea they drink, but coffee still appears to be the preferred stimulant. Perhaps tea then, is a taste more suited to the mature palate.

The health benefits of tea, coffee and chocolate have been studied for as long as they have been known. Chocolate has been used in medicine since the Aztecs discovered it.

References


The full organisational name will still display in your reference list.
Remove citations

Never delete citations by using the delete or backspace keys. It can corrupt your document and the citation will come back whenever you update your citations and bibliography. You need to remove the formatting that links the citation in your document to the matching record in your EndNote library.

To safely delete a citation:

1. Click on the citation in your document to highlight it.

2. Click Edit & Manage Citations on the EndNote toolbar. Check that the correct reference is highlighted in the Edit & Manage Citations window when it opens.

3. Open the Edit Reference drop-down menu and select Remove citation.

4. Click OK to close the Edit & Manage Citations window.
This removes the in-text citation, the reference in the bibliography, and the associated EndNote formatting.

5. Save the changes to your document.

The health benefits of tea, coffee and chocolate have been studied for as long as they have been known. Chocolate has been used in medicine since the Aztecs discovered it (Keen, 2017).

References


Format your bibliography
You can use the Configure Bibliography window to format your bibliography or reference list.

1. Open the Configure bibliography Window
   • On a Windows computer, click on the arrow in the bottom right corner of the Bibliography section of the EndNote toolbar in Word
   • On a Mac, click on the down arrow beside Bibliography in the EndNote toolbar.

2. Under the Format Bibliography tab, the name of your current document should appear in the Format document box. Your selected referencing style will appear in the With output style box

3. Under the Layout tab, you choose the font, add a title, choose the starting number for the bibliography, line spacing (Single / 1.5 Lines / Double), and indentations for references in the bibliography.

4. Make your changes
5. Click on the OK button
Edit your document safely using Convert to Unformatted Citations

While you are writing, you may find that some sections of text need to be edited and rearranged to improve the flow. The citations you insert with EndNote are directly linked to your EndNote library and there is a lot of coding underpinning these links. If you copy and paste text containing EndNote formatted citations, you will end up corrupting your library and could potentially lose it. You need to temporarily make those links inactive to edit safely.

1. Open your document.

2. Go to the EndNote toolbar in Word and open the Convert Citations and Bibliography menu.

3. Select Convert to Unformatted Citations. The reference list will disappear and your citations will appear in curly brackets, e.g. {Martin, 2018 #17}.

4. Select the text you want to relocate, e.g. in this sample document the sections are Tea, Chocolate and Coffee. I want move the Coffee section to second place so I’ve highlighted this section.
5. Cut the text, and paste it to the new position you want it in. For example, the coffee section is now between the Tea and Chocolate sections.

6. Adjust the spacing as needed and repeat as needed throughout the document.

7. When you’ve finished editing, click Update Citations and Bibliography to convert back to formatted citations.

Your reference list will reappear and your citations will return to their normal format. If you click on them they will be highlighted in grey because they are actively linked to your library once more.

8. Save.
Never edit text that includes live EndNote formatted citations. This can corrupt your library and you could lose it.

Never store your document with unformatted citations. Always update citations and bibliography to reinstate the EndNote coding before you save and close your document at the end of an editing session.

It is a good idea to unformat your citations and reformat them periodically as you are working. It's like shutting down your computer and restarting it to fix glitches. This is a way of shutting down your document and restarting it to refresh the connections between your document and your EndNote library.

Combining the chapters of your thesis using Convert to Unformatted Citations
It is a good idea to work on sections or chapters of a longer work separately. However, there comes a time when they need to be combined. If you copy and paste text containing live EndNote formatted citations, you will end up corrupting your library and your document. Need to make those links temporarily inactive to edit safely. The Convert to Unformatted Citations does this so you can edit safely. As an extra precaution, work with copies of the original chapters.

For this example, I am using three chapters with 2 paragraphs and 2 citations each so you can see the whole combined document with reference list pictured at the end of the instructions. The in-text citations are marked in blue text so you can easily see where they are. All three chapters are combined before reactivating the EndNote formatting. If you prefer, you can also work one chapter at a time, reformating the master document after each addition to make sure that it’s worked, then unformatting ready to add the next chapter.

1. Start by making a copy of each chapter. If something goes wrong with one of the copies, you still have the original file.

2. Create a new blank document with the file name for your completed thesis. This will become your master document as the following chapters are added to it.
3. Open this new master document and the of chapter 1.

4. Go to the EndNote toolbar in the copy of Chapter 1 and open the Convert Citations and Bibliography menu

5. Select Convert to Unformatted Citations. This will remove the bibliography at the end of the chapter and citations will appear in curly brackets, e.g. (Martin, 2018) now appears as (Martin, 2018 #17).
6. Select all of the text of the copy of Chapter 1, copy it and paste it into the master document.

7. Go back to the copy of Chapter 1 and click Update Citations and Bibliography in the Endnote toolbar.

8. Save and close the copy of Chapter 1.

9. Open the copy of Chapter 2 and convert the text to unformatted citations.

10. Select all of the text of the copy of Chapter 2, copy it and paste it into the master document on the page after the end of Chapter 1.

11. Go back to the copy of Chapter 2. Update Citations and Bibliography, save and close it.

12. Open the copy of Chapter 3 and convert the text to unformatted citations.

13. Select all of the text of the copy of Chapter 3, copy it and paste it into the master document on the page after the end of Chapter 2.
14. Go back to the copy of Chapter 3. Update Citations and Bibliography, save and close it.

15. In your master document, go to the EndNote menu and select the Update Citations and Bibliography command. Your combined bibliography for chapters 1, 2 and 3 will appear at the end of the master document and the citations be in their usual round brackets.

16. Save the changes to the master document. It is now the master copy of your complete thesis with a single combined bibliography at the end. You may need to do further editing to format headings and spaces. If you need to move sections of EndNote formatted text as part of this editing, convert the text to unformatted citations first. Update citations and bibliography after the text is moved to where you want it.

NOTE: If you are using a Mac, Convert to Unformatted Citations is under Tools.

IMPORTANT: Make at least one back-up copy of your full thesis and store it in a separate location to the original.

Never store your document with unformatted citations. Always update citations and bibliography to reinstate the EndNote coding before you save and close your document at the end of an editing session. If you can't complete the compilation of your thesis in one session, update citations and bibliography of your combined document, and save before closing. When you come back to this, convert the combined document to unformatted citations and continue combing as above.
Remove EndNote coding before you submit your document

When you use Cite While You Write (CWYW) in Word, the document is formatted with field codes that allow EndNote to format your in-text citations and create your reference list. The **Convert to Plain Text** command removes this EndNote formatting from your document so that it is no longer actively linked to your EndNote library. This step is necessary before submitting a copy of your work for marking or review or publishing.

1. Open your formatted document.

2. Go to the EndNote tab in Word and select Convert Citations and Bibliography to bring up the menu.

3. Select Convert to Plain Text.

![EndNote tab menu](image)

4. You will see a warning message, explaining that this will preserve your original document (with EndNote field codes) and create a new, unsaved document (without EndNote field codes). Click OK to continue.

![Warning message](image)

5. A copy of the document, without field codes, appears in a new document window.

![Comparison of original and plain text documents](image)

You can see from the grey highlighting of the in-text citation that the original document on the left still has the EndNote formatting. The plain text document on the right has none.
6. **Save** this plain text document with a different name to distinguish it from the original document. For example, if you are submitting a draft to your supervisor for checking, you could add your supervisor’s name to the end of the file name for this plain text version.

**IMPORTANT:** Convert to Plain Text cannot be undone, so it is important to keep the original document as well. If you need to make further changes, such as including or removing citations using EndNote, this is done in the original document.

Related query: **Why do I have 2 reference lists at the end of my document?**

You are probably working in the plain text document instead of the original. If you add EndNote citations to the plain text document EndNote will start creating a new reference list at the end of it. It doesn’t recognise the existing list because it no longer has the field codes.

Open the original document and make your changes there instead.
Create bibliographies that are not linked to a document
Create an independent reference list
There are times when it is useful to have a list of references that isn’t linked to your writing. For example, you may want to send a list of references to your supervisor to see if you’re on the right track with your research.

You can create an independent reference list without using Cite While You Write. The resulting list will not contain EndNote formatting, so there will be no direct links to your EndNote library.

1. Open your EndNote library.
2. Select the referencing style you need in the Styles box in the toolbar.
3. Highlight the references you wish to include.
4. Use Show Selected References to hide the references you don’t need for your list.
   - Right click on the highlighted references and select Show Selected references from the menu.
   - OR, open the References menu in the tool bar and select Show selected references.
5. Use Copy formatted to copy the references formatted in the chosen referencing style:
   - Right click on the highlighted references and select Copy Formatted from the menu.
   - OR Go to Edit in the toolbar and select Copy Formatted from that menu.


7. Paste the list into the document. It will be formatted in whichever referencing style you have chosen.

8. **Save** the document to your files.
Create a Subject Bibliography

Subject Bibliographies are lists of selected references grouped under the text entered into one or more fields in the records. Separate lists will appear for unique text in each field, e.g. if you have articles by 10 different primary authors, a Subject Bibliography on the Author field will have 10 headings – 1 for each author.

You can select any of the fields in an EndNote record for this function. However, it is only effective if you systematically record the data you are going to use to create the Subject Bibliography headings.

You can use this function to organise a literature review, systematic literature review or systematic review. Below is one example of how to do this.

Create a Subject Bibliography to organise your systematic review

For this example, I’m using the Label field. See Use Change/Move/Copy Fields to organise batches of references under Organise and search your library for how to batch edit the Label field for use in a subject bibliography.

1. Open your EndNote library.

2. Set the referencing style to Annotated. This style appends the abstract to the reference in the bibliography.

3. Highlight the references you need to include in the subject bibliography.

4. Use Show Selected References to hide the references you don’t need for your list.
   - Right click on the highlighted references and select Show Selected references from the menu
   - OR, open the References menu in the tool bar and select Show selected references.

5. Open the Tools menu and choose Subject Bibliography.
6. Select the Label field and click OK.

7. A Subject Terms window will open with a list of the terms in that field. Click Select All to use all of them. Click OK.

8. A subject bibliography will appear. References will be listed under the name of the database, search string, limiters and date searched. Abstracts will be included. Save the list.

You now have a full list of the references you found, complete with abstracts, and sorted by individual searches on specific dates. This list will be useful for the data extraction, screening and writing phases of your systematic review. See the Systematic Review guide for more information on these.
Working with figures
Create a Figure record and attach an image file
Use this reference type for figures (diagrams, photographs, images, maps, graphs or charts, cartoons) stored as image files.

1. Open EndNote

2. Click on the new reference icon , or go to the menu bar and click Reference > New Reference

3. Select Figure for Reference Type

4. Fill in the details of who created the image and where it was sourced from. (Created by, Year, Title, URL if there is one, details of the book or article you found it in, Author address, Creative Commons license, …) This won’t be displayed in your document, but it is useful for you to know because you will need copyright permission to use other’s figures in anything you want to publish yourself.

5. Go to the Figure field.

6. Right click and choose Figure, then Attach Figure…

Or use the Attach Figure icon in the Toolbar at the top of the record

7. Click on Choose File to browse for an image in your files.

8. Select the image file you need from your files and click Open. You will see a thumbnail of the image displayed in the Figure field.

9. Give your image a meaningful name in the Caption field. It is a good idea to include credits/attribution in the caption. When you insert this image into your document. The caption will be displayed.

10. Save the reference

NOTE: Only the original caption will be displayed with your figure in the body of your document. Updating the caption in EndNote after inserting the figure will not change it in your document.
Using EndNote to insert figures into your document

The Cite While You Write (CWYW) function in EndNote also works with figures. You can insert diagrams, photographs, maps, graphs or charts, cartoons or other images into your document from their EndNote records.

EndNote will insert a figure reference in text, e.g. (Figure 1) and insert the image after the paragraph the citation is in. There will be space above and below this image.

1. Insert your cursor at the place in the text where you want to insert the reference to your image. As with in text citations, leave a space between the preceding word and where you want the figure reference to appear. (If it is between two words, leave a space either side of where it will be inserted.)

2. Go to the EndNote tab on the tool bar in Word.

3. Click on the arrow for Insert Citation and choose Insert Figure from the drop down menu.

Tea, coffee and chocolate

Tea, coffee and chocolate are popular beverages. The drinking of tea has always attracted some level of ceremony, but none so much as in Japan where it has become ritualised. Like Art, Tea has its periods and its schools. Its evolution may be roughly divided into three main stages: the Boiled Tea, the Whipped Tea, and the Steeped Tea (Okakura, 1906, p 7).

Chocolate is also popular as a food. According to Purvis (2013) the Spanish people were the first in the Old World to become acquainted with the delights of cacao because they claimed the explorers who conquered and exploited the New World. The western world’s addiction to chocolate spread from there.

There is a long history of cultivation of tea, coffee and cacao plants (Aerts et al., 2011; Garcia L et al., 2014; Thurston et al., 2013). Camellia sinensis gives us tea. The different kinds of tea come from the picking and processing. Coffee comes from a large number of species in the same family, including Coffea Arabica. The cacao tree gives us chocolate.

Males are “more likely to drink Sweetened beverages than females (46% compared with 38%)” (ABS, 2014). This includes coffee. Men’s coffee consumption spikes in middle age. The older men get the more tea they drink, but coffee still appears to be the preferred stimulant. Perhaps tea then, is a taste more suited to the mature palate.

The health benefits of tea, coffee and chocolate have been studied for as long as they have been known. Chocolate has been used in medicine since the Aztecs discovered it.
4. Search your EndNote library for a keyword from the Title or Caption of your figure.

5. Select the figure you want and click Insert.

The figure number will be inserted in brackets where your cursor was and the figure will be inserted below the end of the paragraph.
NOTES:

- Figures and their captions can be repositioned, e.g. centered, after they have been inserted.

- Figures can be resized in the document.

- Updating your citations and bibliography in Word will **not** update the captions of your figures, so you need to make sure you've got the captions you want before you insert your figures. The alternative is to wait until you've converted your document to plain text for submission and manually edit the caption then.

- As you insert figures, Endnote will update the figure numbers to match. If you insert a second image earlier in the document that the first one, the second image you inserted will be Figure 1 and the original Figure 1 will be renamed Figure 2.

---

Tea, coffee and chocolate are popular beverages. The drinking of tea has always attracted some level of ceremony, but none so much as in Japan where it has become ritualized (Figure 1). Like Art, Tea has its periods and its schools. Its evolution may be roughly divided into three main stages: the Boiled Tea, the Whipped Tea, and the Steeped Tea (Okakura, 1906, p 7).

![Image of tea](image1.jpg)

**Figure 1.** Example of modern (informal) use of an outdoor tea ceremony set. Photo by S. Holcroft.

Chocolate is also popular as a food. According to Pumic (2013) the Spanish people were the first in the Old World to become acquainted with the delights of cacao because they claimed the explorers who conquered and exploited the New World. The western world's addiction to chocolate spread from there.

There is a long history of cultivation of tea, coffee and cacao plants (Aerts et al., 2011; Garcia L et al., 2014; Thurston et al., 2013). Camellia sinensis gives us tea. The different kinds of tea come from the picking and processing. Coffee comes from a large number of species in the same family, including Coffea Arabica. The cacao tree gives us chocolate.

Males are "more likely to drink Sweetened beverages than females (46% compared with 30%)
(455, 2014). This includes coffee. Men's coffee consumption spikes in middle age (Figure 2). The older men get the more tea they drink, but coffee still appears to be the preferred stimulant. Perhaps tea then, is a taste more suited to the mature palate.

![Image of tea consumption by age](image2.jpg)

**Figure 2.** Tea and coffee consumption by Australian men in 2011. Data taken from 14066.0.53.007 - Australian Health Survey: Nutrition First Results - Foods and Nutrients, 2011-12 published by the Australian Bureau of Statistics.
Troubleshooting
Correcting Details in an in-text citation or reference list:
You may sometimes notice errors in your in-text citations or bibliography / reference list in your Word document. This is usually a result of errors in the EndNote record. For example, the author names may not be displaying correctly because you imported a database record with all of the author names in capital letters. To correct the errors, you need to edit the EndNote record and then update your citations and bibliography.

There is a long history of cultivation of tea, coffee and cacao plants [AERTS et al., 2011; Garcia L. et al., 2014; Thurston et al., 2013]. Camellia sinensis gives us tea. The different kinds of tea come from the picking and processing. Coffee comes from a large number of species in the same family, including Coffea Arabica. The cacao tree gives us chocolate.

Males are “more likely to drink Sweetened beverages than females (46% compared with 38%)” (ABS, 2014). This includes coffee. Men’s coffee consumption spikes in middle age. The older men got the more tea they drink, but coffee still appears to be the preferred stimulant. Perhaps tea then, is a taste more suited to the mature palate.

The health benefits of tea, coffee and chocolate have been studied for as long as they have been known. Chocolate has been used in medicine since the Aztecs discovered it.

References

To correct these errors:
1. Open your EndNote library.
2. Locate the reference and open it.
3. Check all of the fields associated with the reference list and make any necessary corrections. For this example, the author names that are in all capital letters are highlighted and the Capitalise Each Word option of the Change Case tool is selected to correct them.
4. Save and close the updated record for that reference.

5. Go back to your Word document and click Update Citations and Bibliography in the EndNote toolbar.

EndNote will reformat the references and the bibliography will be corrected.

There is a long history of cultivation of tea, coffee and cacao plants (Aerts et al., 2011; García L et al., 2014; Thurston et al., 2013). Camellia sinensis gives us tea. The different kinds of tea come from the picking and processing. Coffee comes from a large number of species in the same family, including Coffea Arabica. The cacao tree gives us chocolate.

Males are “more likely to drink Sweetened beverages than females (48% compared with 38%)” (ABS, 2014). This includes coffee. Men’s coffee consumption spikes in middle age. The older men get the more tea they drink, but coffee still appears to be the preferred stimulant. Perhaps tea then, is a taste more suited to the mature palate.

The health benefits of tea, coffee and chocolate have been studied for as long as they have been known. Chocolate has been used in medicine since the Aztecs discovered it.

References


We recommend that you always keep a backup version of your Word document as well as your Library.
Journal title abbreviations for your reference list

Some referencing styles require the full journal title. Others require the abbreviated journal title. EndNote's Journals Term List function help with this. Each discipline area list contains the full title and all associated abbreviated titles. The list is linked to the Journal and Periodical Title fields in your article records. When you insert your citation, EndNote will insert the correct form of the title for your chosen referencing style regardless of which form is in the field in the record.

To show abbreviated journal titles in your reference list / bibliography, you will need to replace the existing Journals list with one of the supplied Journal Term lists.

1. Open EndNote.

2. Open the Tools menu, go to Open Term Lists, and select Journals Term List.

3. The Term list window will open at the Terms tab. Highlight all of the terms in the list.

4. Click Delete Term to delete all existing terms from your list

5. Click on the Lists tab and highlight the Journals list.

6. Click Import List.
7. Select the broad discipline area from the options in the file window.

If the Terms lists folder isn't open in the File window, you will need to find it. Navigate to the EndNote Terms Lists folder on your computer. It will be something like C:\Program files\EndNoteX9\Terms Lists. (The program folder for EndNote will include the version number.)

8. Select the discipline area list you want to use.

9. Click Open to import the journal names and abbreviations from the file into the Journals term list

For further information open Help in your EndNote library and read the chapters about term lists.
Removing Author Initials from in-text citations:
For some referencing styles, author initials are supposed to appear in in-text citations when you have multiple authors with the same family name. Most times the problem is multiple variations of a single author name. For example, if one author’s name is entered as "Williams, S J" in one reference in your EndNote library, as Williams, Susan Jennifer in a second reference, and as "Williams, Susan J" in a third reference, EndNote will treat them as three different authors. You will start to see variations such as S Williams and S J Williams in your in-text citations. It is not an EndNote error. It is a data entry error.

You can end up with multiple versions of a single author's name because each database has different ways of dealing with author names in its records. Authors may also use different versions of their name for different publications. You will need to clean up your records to fix the issue.

There are 3 parts to this process:
1. Tidy up your Author Terms List to remove unwanted versions of the name.
2. Tidy up your records to make sure than names are consistently formatted.
3. If the first 2 steps don’t work, edit the citation style template in the Output Style as a last resort.

Part 1: Tidy up your Author Terms
The first step is to edit your Author Terms List to remove unwanted versions of the name, e.g. you would delete Williams, S J and Williams, Susan J.

Williams, Susan Jennifer is the most complete version of the name, so that is the one to keep. If you later add a paper by Williams, Susan Jemima to you library, having full names for both authors will enable EndNote to distinguish between Susan Jennifer Williams and Susan Jemima Williams.

1. Open EndNote
2. Open the Tools menu and select Define Term Lists
3. Select Authors in the Terms Lists window, then click on the Terms tab to open the list of author names you’ve entered.
4. Scroll through the list and delete any versions of the name that you don’t need. NOTE: Names deleted from this list will not be deleted from the records of the references they appear in.

To delete a name, highlight it in the list and click Delete Term. The name will be removed. The list will automatically refresh and it will return you to the top.

5. When you’ve finished editing your Author Terms List, click Close.

Part 2: Tidy up your records
Now that your Author Terms List is clean. The individual records need to be edited to ensure that each entry for the same author is consistently formatted. If you have the Reference Panel open on the right or at the bottom, it will speed this process up.

The deleted versions of author names will appear in red in the EndNote record. This makes them easy to spot for editing.

1. Open the All References group. Working one at a time, locate each record that contains a name that needs editing. Highlight the reference. This will open the record in the Reference panel.
2. Delete the red name and start retyping it. The autocomplete function will fill the rest in.

3. Save the change to the record and move to the next one that needs editing.

4. When you have finished editing all of the records that you need to, open your Word document.

5. Go to the EndNote toolbar.

6. Click on Update Citations and Bibliography in the Bibliography section of the EndNote toolbar. The citations should now be free of author initials.

**Part 3: Edit the output style to remove author initials**
If tidying up all of the author names in your Author Terms List and individual records doesn't fix this issue, and you do not want any initials in the citations in your document, you can edit the output style to turn off this feature.

**In EndNote:**
Open your EndNote library.

1. Select the style you wish to edit in the Output Style box in the toolbar, e.g. APA 6th.

2. Click on **Edit** in the toolbar, and go down to **Output Styles** in the drop down menu.

3. This opens a sub menu. Choose **Edit “chosen style”**, e.g. Edit “APA 6th”. This will open the style edit window.
4. Select **Ambiguous Citations**, under Citations in the left-hand menu. Uncheck the box that reads Include author initials or full name in citation.

5. Select **Author Name**, under Citations in the left-hand menu. Uncheck the box that reads Use initials only for primary authors with the same name.

6. To save changes go to File → Save As and give the style a new name e.g. APAEdited.

7. Close the edit window.

**In Word:**

1. Go to the EndNote toolbar and select the newly edited style in the **Style** box.

2. Then click the EndNote **Update Citations and Bibliography** command to reformat the references in your document using the amended output style.
Superscript numbers for in-text citations

You can modify the citation templates of any style to use superscript numbers for in-text citations. Choose the style you need for your reference list. For this example, I’ve used APA 6th

Edit the citation template

1. Open your EndNote library.

2. Select the style you wish to edit in the Bibliographic Output Styles box in the toolbar, e.g. APA 6th.

3. Click on Edit in the toolbar, and go down to Output Styles in the drop down menu.

4. This opens a sub menu. Choose Edit “APA 6th”.

5. Click on Citations in the left hand menu of the APA 6th Style window. Delete the existing text from the field for Citation on the right.

6. Click Insert Field and choose Bibliographic Number from the menu

7. Highlight Bibliographic Number and
   • For Windows: click the A\(^1\) superscript icon to select superscript as the format.
   • For Mac: open the Edit menu. Go to Font and choose superscript.
   The text will appear as superscript in that field once you’ve done this

8. Next, to get matching numbers in your bibliography, go to the Layout section under Bibliography.
9. Insert your cursor in the Start each reference with box.

10. Open the Insert Field menu above on the right and choose Bibliography Number.

11. Insert your cursor after Bibliography Number in the Start each reference with box and add any punctuation your style requires.

12. Spacing – you will need to put at least one space between the number and the reference:
   - Use the spacebar to add a single space, or to add a specific number of spaces.
   - Choose Tab from the Insert field menu to insert a Tab space.

13. Save the amendments to the style and name your new version of the style, e.g. APA 6th superscript. It will be saved to the Styles folder in your documents on your computer.

**Use the modified style**

- In EndNote: Choose Select Another Style in the Bibliographic Output Style box and select your new style from the list in EndNote.
- In Word: Go to the EndNote toolbar and select the style from drop down menu in Styles box. Use the Select another style option if the style is not already in the list.
Back up your library

You will spend hours developing and maintaining your EndNote library. This is where you keep all of your materials for your research so it is vital that you regularly back your library up. If something happens to your working library, you can resurrect it from a compressed copy.

1. Open your EndNote Library.
2. Open the File menu.
3. Select Compressed Library (.enlx).
4. Select the formatting options that suit you in the Compressed Library window.
5. Click Next and save in a location of your choosing.

Always use the Compressed Library option. When EndNote creates the library, it will also create a .DATA folder which contains various files connected with the library (PDF’s, Groups). When you compress the library, EndNote will include the .DATA folder. If you do not save the .DATA folder with your library .enl file you will not be able to open your pdf attachments or see your groups.

It is recommended that you keep at least 3 back-up copies of your library and document. One copy of each should be in a separate location, e.g. another drive. At least one copy of each should be in a separate physical location from the original library and document, e.g. the originals at home and the copies at work.

CAUTION: Never open or use your library in cloud storage (e.g. OneDrive, Google Drive, CloudStor, Dropbox) or on a storage device such as a USB or an external drive. It will corrupt your library. Cloud storage is only for storage. Always save your working library to the hard drive of your computer. Work from that copy.
How do I get help with EndNote?

Self help

- EndNote’s help section is very useful. Click the Help button on the toolbar of your EndNote library to access this.
- CQUniversity’s EndNote LibGuide aims to show you the basic skills required to get started using the EndNote. It does not cover everything you will ever need to know.

For help installing EndNote, or fixing software issues contact TaSAC:

- Call from a Video kiosk in any campus library
- Call from your phone: 1300 666 620
- Call from a campus phone: extension 59090
- Email your request to tasac@cqu.edu.au
- Submit a request via the online Self Service Portal

For help using EndNote

- Contact TaSAC as above. Email queries are assigned to the Librarians Online Team (LOT). Calls are redirected to LOT if a librarian is available. If not a job is created and assigned to LOT so a librarian can respond when available.

OR

- Book a virtual face to face Ask a Librarian session at a time that suits you. Please note that all sessions are scheduled in QLD time. You will need to allow for that if you are in a different time zone.